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Questions/Answers

Continued from page 5

into CCQAS, his/her license is                            

current so I enter status code "C" on the licensure screen.  Subsequently, the license expires, but the status still shows as "C" (current) on the licensure screen.  Why?

A:  When CCQAS was designed, no functionality was incorporated into the program to check expiration dates and to automatically change the status upon expiration.  In the present 1.5 version of CCQAS, the user would need to use the change option to change the status code.  When version 2.0 of CCQAS is fielded, it also will not programmatically change the status code, but there will be the option to set up the program so that a user goes to the licensure screen for a given provider, a warning message will be displayed indicating that the

license has expired or will expire in the

near future.

Q:  If I know the DMIS code, do I still have to search for it, or can I just enter it myself?

A:  The program will allow for both searching or data entry.  The program will check your entry against the list of DMIS codes for validation.  If it does not recognize your entry, it will give you all the codes that most closely match and ask to pick the correct code.

Q:  I'm a user who does some credentialing and some risk management.  I need permission for both modules.  What do I do?

A:  Make yourself a user in both a credentialing and a risk management group that is not using the default permissions.  In other words, choose limited permissions for these special  types of groups.

Q:  CCQAS 2.0 has an assortment of tables where CCQAS 1.5 only had one.  How will I know which tables to join together in order to create an ad hoc report?

A:  CCQAS 2.0 will be deployed with table views.  A view is a computed table that combines data from more than one table.  In many respects, it looks and acts just like any other table in the database.  CCQAS 2.0 will create a view of the most "used"  credentialing information, and another view for the most "used" risk management information that will make creating ad hoc reports much easier.


The Present and Future of CCQAS


CCQAS to Add Privileging Capabilities


By LtCol Jim Williamson


Chairman, CCQAS Configuration Control Board                          OASD(HA)/TMA Functional Representative


For over two years, I've been with the CCQAS team, and it has certainly been an interesting ride … to say the least.  So much has happened with so much yet to come.  


Unfortunately, Version 2.0 has taken longer to develop than we would have liked due to funding and contractor issues.  But our primary goal has not changed.  We are dedicated to bringing you a product vastly improved over the first.


To this end, the functional and technical Service representatives to the CCQAS Configuration Control Board (CCB) have put a significant amount of work into this project and are continuing to do so.  I would like to thank all of them for their hard work.  I also want to take this opportunity to thank everyone at the Active Duty, Guard, and Reserve sites for making Version 1.0 a success and for their invaluable assistance with the development of Version 2.0.


The next logical step in the evolution of CCQAS will be the incorporation of provider privileges into the program (Version 3.0).  The concept will be to develop common language privilege lists for each provider category based upon, and possibly mapped to, ICD9-CM and CPT4 codes.  The main 
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The Present and Future of CCQAS - Williamson


goal is to have the functionality for sorting providers based upon privileges that would enhance both readiness and peacetime operations for putting the right provider in the right place at the right time.  Presently, CCQAS 2.0 functionality addresses credentials, risk management (malpractice and adverse actions), and readiness (limited data).  Without the privileging component, however, the software is incomplete.  


Our next challenge, after completing development and deployment of Version 2.0, will be to add the privileging piece to CCQAS.





LtCol Williamson is assigned to the Office of the Assistant Secretary of Defense (Health Affairs) Tricare Management Activity as the Functional Representative.
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Byline Company - Use this style to type the author’s company.


Sidebar Head - Use this style to type a second-level heading in a sidebar article.


Sidebar Subhead - Use this style to type a third-level heading in a sidebar article.


Sidebar Text - Use this style to type the text in a sidebar article.


Sidebar Title - Use this style to type first-level headings in a sidebar article.


Footer - Use this style to type the repeating text at the very bottom of each page.


Heading1 - Use this style to create headlines for each article.


Heading2 - Use this style to create section headings in an article.


Jump To and Jump From - Use these styles to indicate that an article continues on another page.


Mailing Address - Use this style in a mailing label to type the destination address.


Postage - Use this style in a mailing label to type postage information.


Return Address - Use this style in a mailing label to type your address.


Picture Caption - Use this style to type a description of a picture or illustration.


Subtitle - Use this style to type sub-headings in an article.


Use PullQuote to excerpt text from the main text of a story to draw a reader’s attention to the page. See page 4 for an example.
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CCQAS Update


SYBASE Developing CCQAS 2.0


By Jennifer Brown, Project Manager


In August, Sybase Professional Services of Silver Spring, MD assumed contractual responsibility for the successful deployment of the CCQAS Version 2.0 system.  Sybase has completed its familiarization with the current system and has developed a Project Plan, a Project Definition Document, and a Quality Plan, as well as obtaining final approval signatures from MHS personnel on these documents.  It is anticipated that replication changes, database development, NPDB/QPRAC interface, PrivPlus interface, and the application development will be completed by early December.  Target date for CCQAS 2.0 deployment is April 1999.


Dan Bucchioni, Sybase's Practice Manager for Public Sector Professional Services, indicated that  "[Sybase] takes particular pride in delivering on time and on 


budget.  We specifically apply our quality plan and our program methodologies to assure rigor in the process while there is still time and the resources to face those issues."  He indicated that Sybase is prepared to talk about its quality and delivery plans to anyone.


According to Bucchioni, Sybase is one of only three professional companies in the world who are ISO 9001 certified, meaning they meet the basic tenant of ISO 9001 … "to generate repeatable processes which are used for delivery. "


Kudos to Sybase Senior Consultants Tom Gregory and Dave Purvis for their CCQAS development efforts to date.





Y2K Compliance


Are You Y2K Compliant?


By Diane Reed, CCQAS Functional Analyst





Are you wondering if CCQAS will be Y2K compliant when the year 2000 arrives?  The answer is …


Version 1.5 is Y2K compliant.


It will accept dates through year 2030.  CCQAS 2.0 is currently undergoing certification, with official certification scheduled prior to deployment in April of next year.


Please note:  Version 2.0 will run under Windows 3.1, Windows 95, Windows NT 4.0.  


For further information regarding Y2K compliance, see the following web sites:


Windows 3.1 www.microsoft.com/ithome/topics/year2k/product/win31.htm


Windows 95


www.microsoft.co/ithome/topics/year2000/product/Win95OEM.htm 
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Windows NT 4.0


For Service Pack 3, see 


http://backoffice.microsoft.com/downtrial/moreinfo/nt4sp3.asp


For Y2K QFE Fixes, see


http://backoffice.microsoft.com/downtrial/moreinfo/


y2kfixes.asp


Got Microsoft Site Server Express 3.0, see


www.microsoft.com/msdownload/siteserver30/ssx/ssx.asp











CCQAS 2.0 Facelift


What's Upcoming for You, the User


By Amy Fine, CCQAS Super Database Administrator


The development phase of the upcoming version of CCQAS 2.0 continues making great progress!


Significant changes to the database design have taken place recently that will allow for major data capture, flexibility, and expandability.


Major changes have also been made to the user interface.  Navigating through the application will be easier, and users will be able to view more screens at the same time.  The flexibility of user access has increased as well.


Gamma testing is eagerly anticipated for February 1999.  Upcoming issues of this newsletter will feature more CCQAS 2.0 news. 


Thanks to everyone for making the CCQAS 2.0 development phase a huge success!





Amy Fine is located at the offices of the Armed Forces Institute of Pathology (AFIP) in Silver Spring, MD.


Her e-mail address is


FineA@afip.osd.mil
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Calendar of Events


AMSUS Conference -- CCQAS on Exhibit


Place:    Conference Center


                   San Antonio, TX


Exhibit


DATES: November 9, 10, 11, 1998





CCQAS will be an exhibit participant, and providers visiting the exhibit will be able to use CCQAS to check their current credentials on file.





TRICARE CONFERENCE


Place:   Marriott Wardman Park Hotel


                  Washington, D.C.


Exhibit


Dates:   January 30-February 6, 1999





CCQAS 1.5 and 2.0 will be on exhibit.  More details to follow.











HELP !!


HAVE YOU SUBMITTED YOUR  PRE-DEPLOYMENT


SITE SURVEY ??





A pre-deployment site survey has been sent to you for completion so we can determine your needs regarding architecture, hardware, infrastructure, and software, as well as your POCs for the deployment of CCQAS Version 2.0.


If you have not yet completed and returned this site survey, please do so immediately.


Here are the appropriate addresses by Service:


Jerry Yelverton - Army - fax (210) 637-4657 (or call direct to Jerry at (210) 221-9775X724 or Dot Keaton at X340 to provide the info via telephone)


John Bird - Air Force - fax (202) 767-5302


Don Riggs - Navy - fax (904) 542-7209








CCQAS Questions and Answers


By Gary Bonnell


Database Administrator 





Q:   In the CCQAS Main Browser, I can only see part of the records that I've entered.  I know there are more records, but they don't show on the screen.  Why?


A:   This situation is generally due to a minor problem with the database structure/indexing.  Your database has probably become slightly fragmented, and the system is "getting lost" when trying to locate the records based on the indexes.  Reindexing the database will generally solve the problem.


Q:   When I run the standard License and/or Privilege Expiration reports, not all of the providers who fall within the date range I specified show on the report.  Why?


A:   When the License and Privilege reports were developed, criteria was built into the reports that records are only selected if the privilege category (on the specialty screen) is equal to "R."  If you want to get data for providers with other privilege categories, you'll need to do so via an ad hoc report.


Q:   I find that the ad hoc report generator is restrictive in terms of allowing me to format reports in the manner I want and/or to set some of the more complex selection criteria I would like to use.  Are there other tools/software that I can use to generate reports on my CCQAS data?


A:   CCQAS stores data in dBase (.dbf) format.  Software that will read a dBase formatted file can be used to generate reports as necessary.  Some examples of software that will read the data and can be used to generate reports include MS-Access and MS-Excel.  


Q:  When I enter a provider's data
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incorporated into the program Footer toolbar to navigate among headers and footers, insert date or time, or format the page numbers. To change the text in the footer, select it and type your new text. To change the border, click Borders and Shading on the Format menu.


Q:   Can I save a customized newsletter as a template for future editions?


A:   Yes. Type your own information over the sample text and then click Save As on the File menu. Choose Document Template from the Save as type drop down list (the extension should change from .doc to .dot). Save the file under a new name. Next time you want to create a newsletter, click New on the File menu, then choose your template.

















VISIT THE CCQAS BOOTH


AT AMSUS …


CHECK YOUR CURRENT CREDENTIALS





Service representatives will be on hand at the CCQAS booth of AMSUS in San Antonio on November 9, 10, and 11 so you can enter your info into the system and examine the current status of your credentials on file. 


Stop by between 12 noon and 3:00 p.m. on Monday, 10:00 a.m. to 3:00 p.m. on Tuesday, or 12 noon to 3:00 p.m. on Wednesday for a free "check-up."





Note:  Jennifer Brown, CCQAS Project Manager, and MSgt Jay A. Cline, Sr., Chief of the Executive Services Branch of the Air Surgeon Directorate, will be providing a demo briefing of CCQAS on Sunday afternoon before the ANG Medical Service Corps Officers Society at AMSUS between the hours of 1:00-4:30 p.m. in Salon A of the Marriott Riverwalk.
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Do you have CCQAS questions you would like answered in this column?  If so, please forward them via  e-mail to 


diane.reed@tma.osd.mil


 for inclusion in a future newsletter.











CCQAS NEWS   1

_971091491

